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“What makes Scott Gregory unique
amongst the QuickBooks Experts
we have hired is his very practical
approach to tailoring QuickBooks
to our needs. His very in-depth
knowledge of the “inner workings”
of QuickBooks has transformed our
operation in a very short time.
He may appear a bit more expensive
than other QuickBooks experts until
you realize that he covers in an hour
what takes others many, and has made
our operation smooth and stress-free
through clever short-cuts so few
know of.
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I highly recommend him for setting up
QuickBooks right. My employees know
much more about QuickBooks now, as
he has made it simple to use, and has
showed us how to avoid issues in the
future. In just a short time with Scott, he
has made something which appeared
daunting and difficult to use,
simple and effective.
I now can sleep at night knowing that
my business is under control, and I
can accurately view the state of my
business at any moment by simply
opening QuickBooks. Scott has not
only made this possible, but did so in a
very cost-effective manner. “
- David Marcarian, President
Precision Biometrics, Inc. / MyoVision

Contact Scott Today About QuickBooks
For the fastest response, email Scott at:
Scott@BetterBottomLine.com
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Don’t let QuickBooks be a pain in the asset!
• Getting headaches from trying to figure out QuickBooks?
• Tired of hearing “accountant-speak” from your CPA?
• Frustrated with the QuickBooks tech support group?
• Discovered your accountant doesn’t know QuickBooks?

Help is here!

Benefit from having a trusted, professional advisor on your team at a fraction
of the cost of full-time staff. My clients enjoy our working relationship simply
because I don’t talk “accounting or technology speak” – I can discuss your
problems and offer solutions in plain English. See what my clients are saying
about the help and insight I have provided for them.
Contact me for help before you throw up your hands in frustration! Working
together, we can determine the extent of your QuickBooks problems and
put a solution in place. Let’s get your QuickBooks and accounting problems
ironed out soon!

“Your training has literally revolutionized the way we run things here.
Everyone in our entire company- from Customer Service, Purchasing,
Marketing, Shipping to Management has benefitted greatly from what
you have taught us!

 ABOUT SCOTT

Contact Scott
Today About
QuickBooks
For the fastest response,
email Scott at:
Scott@BetterBottomLine.com

 CONTACT SCOTT

I couldn’t recommend your expertise more- I would tell any
Quickbooks user that a session with you is mandatory. The ROI is
literally 50 fold for ourcompany.”
- Victoria Marquard-Schultz, Esq.,
General Counsel & Regulatory Director
Applied Home Healthcare Equipment, LLC
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Proactive Steps You Can Take

There Is No Early Warning System In Quickbooks
I am positive you have discovered that QuickBooks software is very capable of alerting you to opportunities
to purchase an upgrade.
In addition, you have likely been subjected to various pop-up messages offering you “special promotions”
on complementary QuickBooks services such as payroll and credit card processing.
Those notices are all fine and dandy (some would say they are excruciatingly annoying!), but what about
getting notices relating to the health of your QuickBooks data? After all, you and your staff have invested
(or will have!) hundreds of hours of sweat equity building the data file.

Unfortunately, there really isn’t any early warning
system to alert you to potential problems with
your QuickBooks data.

Why risk finding out the hard way that a problem is lurking inside your file. There are some proactive steps
described in more detail below that you can take to keep an eye on things.

The Power Of The F2 Key
Hidden inside QuickBooks is a screen that
can provide details and insight into the state
of affairs with your QuickBooks file.
That screen is accessed by tapping the F2
key on your keyboard (across the top row of
keys). Once you tap it, a screen like this will
appear...
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Proactive Steps You Can Take
Breaking Down The Key Details On The Product
Information Screen
Don’t let all this geeky looking stuff on the screen shot above scare you away. Let’s take a look at a few of
the details within the screen that we’ll be focusing on in this publication…
PRODUCT
In the example above, it is telling us that QuickBooks Premier Accountants Edition 2016 Release R7P
is installed.
● Key insight – the “R7P” portion of this information tells you what update or “release” of QuickBooks
			 software is installed. These releases are how QuickBooks ensures that any bugs and problems
			 reported by users like you are fixed.
			 It is extremely important to keep your QuickBooks software up to date with the latest release. To ensure
			 you have the most current release, click Help > Update QuickBooks and follow the prompts or check
			 the QuickBooks support site for your product to ensure you have the latest update.
LICENSE NUMBER AND PRODUCT NUMBER
This information is crucial in the event you ever need to re-install your QuickBooks software. Be sure
you have it tucked away with your important computer files and paperwork. These numbers are normally
included on the yellow product sticker inside the jacket of your QuickBooks CD or provided with the
information you received when you downloaded the software.
FILE SIZE
This information tells you just how big your QuickBooks data file is. In this example, the file size of 36432k
is telling us that the file is about 36 megabytes (MB) in size. This number becomes critical to our
conversation later in this guide.
DB FILE FRAGMENTS
This tells you just how unorganized the data is within your QuickBooks data file. A smaller number is
better in this case. See the details below on acceptable values.
LIST INFORMATION
Tells you how many customers, vendors, etc. you have
in your various QuickBooks lists.. QuickBooks does have
limits for how many names you can have in these lists.
Details on that on the right.
Scott@BetterBottomLine.com
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Proactive Steps You Can Take

Who Cares About This Stuff?
You should. No, really. You should care a lot.
Specifically, there are three critical pieces of information above that can have a significant impact on your
daily use of QuickBooks.
The critical pieces are:
● DB File Fragments
● List Information
● File Size
Let’s explore these critical pieces in more detail…

 DB FILE FRAGMENTS

DB is shorthand for database. The more fragmented your QuickBooks database is, the slower it will run. It
is up to you to keep your database organized – QuickBooks isn’t going to do it for you. It won’t even warn
you that it is getting disorganized.
Key value: Based on guidelines I have seen from QuickBooks, the key number for your DB file fragments
is 30 or less. Realistically, my opinion is that if you can keep this value less than 75, no further action is
needed. If your value is more than 75, you will want to consider further action to reduce it as explained below:
ACTION STEPS TO REDUCE THE DB FILE FRAGMENTS:
●
			
			
			
			

Use the Rebuild Data tool found by clicking File > Utilities > Rebuild Data. A wizard will run to help you
through the process. The first thing it does is get you to create a backup copy of your QuickBooks data
(you can NEVER have too many backup copies!); then it goes through a reorganization process that
can take anywhere from 10 minutes to 2 hours depending on how big your QuickBooks data file is.
Once this has completed, check your DB fragments again to see what the number is now.

● If it is still too high, you will want to use the disk defragmentation tools provided by your version of
			 Windows. For example, in Windows 7, you can click Start > All Programs > Accessories > System
			 Tools > Disk Cleanup and the following will appear:
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● Just click the Defragment button and walk away until it finishes. Once done, re-check your DB file
			 fragment value.
			 + Key points:
					 - You will need to run this defragmenting software on the computer where your QuickBooks data file
					 resides. If that is on a server in your business, be sure to consult your IT person for guidance.
					 - Best bet is to run this process overnight when nobody is using the computer.
●
			
			
			
			
			

Create and Restore a Portable company file – If you click File > Create Copy, the next screen presents
an option called “Portable Company File.” This process can be used to try and reduce the amount of “
DB fragments in your QuickBooks data file. The steps are as follows:
+ Create the portable company file following the wizard
+ Immediately restore the portable company file using the wizard
+ Tap F2 and verify the DB fragment count once again

 LIST INFORMATION

Each version of QuickBooks has a limit to how many customers, vendors, items and other information it
can hold.
For example, in QuickBooks Pro and Premier, the maximum number of customer, vendor and
employee names it can hold is 14,500. This is a total figure – you don’t get 14,500 customers, 14,500
vendors, etc. By contrast, QuickBooks Enterprise can hold up to 100,000 customers.
Just as importantly, QuickBooks Pro and Premier can only hold a total of 14,500 item/part numbers as well!
In many businesses, this limitation isn’t a concern. However, for many others, it could cause real problems.
The information provided by tapping the F2 key will alert you to just how many
entries you have in your various lists. As I mentioned, QuickBooks does not
provide any warnings that you are getting close to hitting the limits. It is up to
you to periodically check the status.
Scott@BetterBottomLine.com
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OPTIONS FOR RESOLVING THIS PROBLEM:
Unfortunately, there are not many options to choose from to address this particular problem. These options
would be:
● If you are using QuickBooks Pro or Premier – you can migrate to QuickBooks Enterprise. Your list
			 capacity goes from 14,500 to 100,000, so you have room to grow. Naturally, there is the cost of
			 Enterprise to consider (REMEMBER: I can save you $$ on your purchase of Enterprise).
●
			
			
			

Start a new QuickBooks company data file – if you create a new data file, you are then able to delete
the names within the list that you no longer want to retain. This allows you to create some space and
grow your list counts again. (IMPORTANT: Be sure to read the pros and cons below about starting a
new company data file).

			 MYTH: If I have too many entries in my list, I can simply delete names as needed.
			
			
			
			

REALITY: To maintain the integrity of your QuickBooks company data, if a name in your list has ANY
transactions associated with it (i.e. estimate, invoice, etc.), you will NOT be able to delete the name
from the list. You will be able to make the list entry inactive, but that does NOT reduce the number of
entries within the list and does not free up any space.

 FILE SIZE
THIS IS SERIOUS BUSINESS AND WHERE IMPLOSIONS CAN OCCUR!
When looking at the details displayed with the F2 key as mentioned above, you see the file size line:

Monitoring the size of your QuickBooks company data file is a critical area in the care and feeding of the
file that you need to know about.
ACCEPTABLE FILE SIZES:
● QuickBooks Pro and Premier: 300,000 (300 Megabytes) OR LESS. In the graphic above, the file size is
			 36,432, so it is nowhere close to the 300,000 limit and it has plenty of room to grow. Your file may not
			 be so fortunate.
			 KEY TIP – This value is not published anywhere in the QuickBooks documentation. Rather, it is based
			 on my observation of hundreds of QuickBooks data files over the last ten years and suggested
			 guidelines provided by QuickBooks.
This is not an exact figure, but rather, a key indicator that problems may surface down the road. I know
of businesses that have file sizes in excess of 300,000, but they are also experiencing one or more of the
symptoms discussed on the next page...
Scott@BetterBottomLine.com
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COMMON SYMPTOMS OF FILES THAT ARE TOO LARGE AND POTENTIALLY HEADING
FOR TROUBLE
Are you running into any of these issues in working with QuickBooks:
1.
			
			
			
			

You go to run a report, and it “takes forever” for the report to display? By far, this symptom is the
most common and easiest to spot. I have worked with businesses that wait anywhere from three to five
minutes (or more) to generate their profit and loss and other important reports. This is a classic
symptom that the underlying QuickBooks data file is getting too big and action is needed (sooner
rather than later!).

2. You get random error messages when opening, closing or working in QuickBooks or QuickBooks
			 shuts down all by itself? In many cases, these error messages are related to some type of problem
			 within the QuickBooks data file that needs to be sorted out.
			 TRUE STORY – The only way to get it working again was for the Intuit data team to try and run some
			 repair tools on it. If they sent the file to the Intuit data team, they would have been without the file for 2-4
			 business days (that’s right – nobody could use QuickBooks at all during that time).
			 We then got the QuickBooks data recovery team involved and the business was told that their
			 QuickBooks company data had become corrupted and was unusable. Great news….not!
			 The only way to get it working again was for the data team to try and run some repair tools on it. The
			 business then had a choice – pay the data team $250 and be without the use of QuickBooks for 7-10
			 business days, or pay the data team $750 and be without the use of QuickBooks for 2-4 business days.
			A MAJOR OUCH either way!
3.
			
			
			

You can’t verify, rebuild or backup your QuickBooks data properly? Failures in these common
QuickBooks utilities typically indicate that there is some type of underlying problem within the
QuickBooks data that needs immediate attention. Very often, the culprit is that the data file has become
too large and the data integrity has become suspect.
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WHAT ARE THE OPTIONS IF YOUR QUICKBOOKS DATA FILE BECOMES TOO BIG?
Each of the following potential solutions has pros and cons that you will need to evaluate in relation to the
needs of your business.
● Start a new QuickBooks company data file – yes, this is exactly what you think it is. Starting a
			 new data file from scratch, just like you did the first time. Alternately, you can outsource this project.
			More details on outsourcing your new file here.

			 PROS:
			 + Your QuickBooks company data file will be extremely small once again and allow you to grow. It
					 should take a while before you return to the “red zone” of a file size approaching the 300,000
					 megabyte mark as referenced above.
			 CONS:
			 - You will need to move your customer, vendor, item and other lists from the old company file to the
					 new one. QuickBooks provides the utilities to do this, but this process brings over all your list
					 entries, including old customers and vendors.
			 - You will need to get your open A/R, A/P and ledger balances into the new data file. Depending on
					 the volume of open customer and vendor invoices, this could be a very time-consuming process.
			 - Once you get the new data file created, you will not be able to run comparative financial reports
					 without the intermediate use of Excel. Your old transactions will be in the “old” company data file
					 and your new transactions will be in this “new” company data file. Any comparisons will have to be
					 done with Excel.
			 - You will have to jump back and forth between the company files. Since QuickBooks only allows you
					 to have one data file open at a time, you can either access the “new” company data or the “old” at
					 any given time. While the process of jumping back and forth is easy to do, some perceive this as too
					 much of a “pain” to want to deal with it. Keep in mind that your old data is NOT lost in any way –
					 you just have to take a few extra steps in order to access it.
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● Use a QuickBooks file-shrinking service – several third party firms have the capabilities and the
			 proprietary tools that can be used to try and condense your QuickBooks company file so you can keep
			 working without the aggravating problems outlined above.
			 My favorite solution is provided by Mendelson Consulting. Their “super-condense” service allows you
			 to make your QuickBooks data file as clean and efficient as possible on a risk-free basis.
			 PROS:
			 + Mendelson Consulting will assess your data and let you know the potential file size reduction at no
					 cost. If they are not able to free up a sufficient amount of space to speed up your QuickBooks, there
					 is no charge. You are not obligated to proceed with their service.
			 + If they are able to free up significant space, the resulting QuickBooks company file will work faster
					 and be far less prone to some of the problems mentioned above.
			 CONS:
			 - There is a cost to use the Mendelson Consulting service if you agree to have them proceed with
					 a “super-condense” of your QuickBooks company data file. The prices are very modest for the
					 huge benefit they provide. Note that they offer weekend services to help minimize the potential
					 disruption to your business.
● Migrate to QuickBooks Enterprise – The makers of QuickBooks realize that your business may simply
			 outgrow the capabilities of the Pro or Premier versions. Naturally, they have made it a snap to move
			 into their Enterprise version of QuickBooks.
			 This version can easily handle data files up to six times the size of QuickBooks Pro or Premier (2 gigabytes
			 for Enterprise vs. 300 megabytes for Pro or Premier).
			 PROS:
			 + Moving from QuickBooks Pro or Premier to QuickBooks Enterprise is usually a seamless transition.
					 ● The user interface within Enterprise is exactly the same as it is in Pro or Premier, so there is no
					 additional learning curve for you or your staff
					 ● All of your existing QuickBooks data will move into Enterprise. Unlike the option above to create
a new company data file and have your data split between two data files, Enterprise allows you to
keep running with your existing file.
					 ● Your purchase of QuickBooks Enterprise includes a free upgrade to the software when it is
released. For example, if you purchase QuickBooks Enterprise, you would automatically receive a
free upgrade to the next release of QuickBooks Enterprise.
			 CONS:
			 - There is a cost involved in purchasing QuickBooks Enterprise software. Keep in mind that I am
					 able to save you a significant amount on the purchase price of QuickBooks Enterprise, but there is a
					 cost involved. Some businesses feel this cost it too much and opt to try the other options listed
					 above first.
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Summary
The care and feeding of your QuickBooks data file is extremely important, but often overlooked. As you
have seen, there are a number of issues relating to your data that are of specific concern and that need
periodic monitoring.
The good news is that you have some options to consider in the event your data file is getting too big. Is
there one right solution for your business? My thought is to weigh the pros and cons as outlined and make
the determination of what is best for your business not for the short-term, but in the longer term.
It is best to be proactive in monitoring your QuickBooks – that way, you can address these concerns on
your own timetable instead of being rushed into a poor decision because you can no longer access your
critical QuickBooks company data.
If you have the need for further professional assessment of your QuickBooks file and/or help in reviewing
the critical information above in your business, let’s talk soon.

“Scott is extremely knowledgeable in Quick Books and very friendly. I have had an issue with this
program since we purchased it and with Scott’s help, I have been able to grasp a better understanding
and actually put the program to correct use. Scott makes your learning experience relatively painless
and interesting. Scott listens to your concerns and addresses them by importance and never makes
you feel stupid for not understanding. Scott, thank you for all of your help!
- Heather, Royal Sheen Products

Want to learn more... FOR FREE???

 LEARN MORE

Additional Guides Available at our Website!
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“I would definitely recommend Scott Gregory to anyone.”
- Margo Strunk, Office Manager, AllCraft Wellman, Inc.

QuickBooks Services

Take the guesswork out of using QuickBooks for your financial needs – get the help of
a trusted QuickBooks expert that has been helping businesses for years:
One-To-One Consultation

Let me help resolve areas of confusion and ensure you are using QuickBooks the right waydon’t waste time sitting in a “QuickBooks class” and then discover the class doesn’t answer
your specific questions! We can nmeet on-site or over the Internet for as little as an hour, or as
long as it takes to get things right!

Initial Quickbooks Setup

Just starting with QuickBooks? If your company data file is not set up correctly, you will be
paying for it over and over again in higher accounting fees and troubleshooting expenses.
Ensure you start your QuickBooks journey with a solid foundation! Don’t blow this critical step
in your QuickBooks journey.

Unlock The Secrets To Using QuickBooks More Effectively

Take advantage of my expertise to work with you and your staff and adapt QuickBooks to the
specific needs of your business. You don’t even have to leave the office!

Conversion From An Existing System

Tap into my expertise to help minimize the pains of converting to QuickBooks and ensure
success for you and your team! Moving from your existing accounting software to QuickBooks
doesn’t have to be a scary or budget-busting event.

Help Selecting The Right QuickBooks Add-On Software

Trying to extend the functionality of QuickBooks? Avoid the classic mistakes many businesses
do when looking for new software, especially packages that integrate with QuickBooks. Work
with a QuickBooks expert to ensure your success.

Contact Scott Today
About QuickBooks

Save 20% on a
consultation with Scott!

For the fastest response, email Scott at:
Scott@BetterBottomLine.com

(2 hour minimum)

 CONTACT SCOTT

 SAVE 20%
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“Thanks for making our upgrade painless and easy!”
- Doug Freer, President, LawnLad, Inc.

QuickBooks Desktop Enterprise for Windows
• Save 20% on EACH year of your subscription!
• Includes Manufacturing, Contractor, Non-Profit Retail and 			
Professional Services Editions
• Get free shipping or download
• Easy upgrade from current version of QuickBooks
• 60 day money-back guarantee
 MORE INFO / BUY NOW

QuickBooks Premier for Windows

• Save $$$!
• Get free shipping or instant download
• Easy upgrade from current version of QuickBooks
• 60 day money-back guarantee
• Includes Manufacturing, Contractor, Non-Profit Retail and
		 Professional Services Editions
 MORE INFO / BUY NOW

QuickBooks Pro for Windows

• Save $$$!
• Get free shipping or instant download
• Easy upgrade from current version of QuickBooks
• 60 day money-back guarantee
 MORE INFO / BUY NOW

QuickBooks Online

• Save 50% on the first 12 months of your QuickBooks Online subscription!
 MORE INFO / BUY NOW

Scott@BetterBottomLine.com
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“Scott Gregory continues to amaze me. Every single client out of the dozens who have purchased Enterprise
Solutions from Scott and worked with him have given him a 100% Net Promoter Score. This is very unusual
in our industry. It is considered World Class.” – MARIE ARCHULETA, Channel Sales Manager for Intuit

About Scott Gregory

Certified QuickBooks Enterprise Advisor and Intuit Premier Reseller

Scott has been helping businesses “get it right” with their QuickBooks and
business finances for over thirty-five years.
During that time, he has assisted well over 1,000 businesses, with services
such as QuickBooks software installation, training and coaching sessions,
and his part-time controller services.
Prior to starting his own practice, Scott served as the CFO for a $15 million
manufacturing firm for more than ten years. During his tenure as CFO, Scott
was responsible for: $4 million in inventory, $4 million in accounts receivable,
inventory control, purchasing, information technology and banking
relationships.
He is a member of the Certified QuickBooks ProAdvisor program, a CPA, and
certified in integrated resource management (CIRM) by APICS. Scott has
taught hundreds of business owners, bookkeepers, and CPAs how to use
QuickBooks effectively and efficiently through local community colleges and
via webinars.
Thousands of QuickBooks users rely on Scott’s QuickBooks Blog for insight,
tips and tricks each and every month.

Contact Scott Today!

For the fastest response, email Scott at:

 Scott@BetterBottomLine.com
 1.888.581.2839
 www.BetterBottomLine.com
Save Money On Your
QuickBooks Upgrade!

FREE QuickBooks
Guides

Visit Scott’s Blog:
Understanding QuickBooks

 CLICK HERE

 DOWNLOAD NOW

 READ NOW
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